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1 INTRODUCTION 

1.1 REFERENCES 

Ref 1 Bathyswath-PSM web page, at https://www.iter-systems.com/bathyswath-2-psm/ 
Ref 2 PDF format description, at https://en.wikipedia.org/wiki/Portable_Document_Format  
Ref 3 Java Runtime Environment, available from: 

http://www.oracle.com/technetwork/java/javase/downloads/index.html  
Ref 4 Jaspersoft Studio User Guide, at 

http://community.jaspersoft.com//system/files/restricted-docs/jaspersoft-studio-user-
guide_2.pdf  

Ref 5 Jaspersoft Studio home page, at http://community.jaspersoft.com/project/jaspersoft-
studio  

Ref 6 IHO S44, available at https://www.iho.int/iho_pubs/standard/S-44_5E.pdf  

 

1.2 GLOSSARY & ACRONYMS 

ACRONYMS DEFINITION 

PSM Permanent Siltation Monitoring: a fixed location, scanning 
implementation of Bathyswath for monitoring siltation 

PSM_Report The name used in this document for the PSM reporting application 
that it describes 

  

 

1.3 SCOPE 

This is the user manual for the PSM_Report software system. 

The report provided by the Application is called “the Report” in this document. 

This document is aimed at people who need to install and maintain the PSM_Report system. 
People who only need to read the reports do not need to read this manual. 

1.4 CONTEXT 

Bathyswath-2 PSM is a sonar system, located at hydroelectric dams and cooling water inlets, 
to monitor siltation of the bottom [Ref 1]. PSM_Report is a software application that makes 
the data provided by these systems accessible to personnel who are not survey specialists, by 
automatically creating a PDF report, which shows a map of the depth data recorded by the 
sonar, together with analysis data extracted from it and all the relevant date, time and place 
information. 

  

 

  

https://www.iter-systems.com/bathyswath-2-psm/
https://en.wikipedia.org/wiki/Portable_Document_Format
http://www.oracle.com/technetwork/java/javase/downloads/index.html
http://community.jaspersoft.com/system/files/restricted-docs/jaspersoft-studio-user-guide_2.pdf
http://community.jaspersoft.com/system/files/restricted-docs/jaspersoft-studio-user-guide_2.pdf
http://community.jaspersoft.com/project/jaspersoft-studio
http://community.jaspersoft.com/project/jaspersoft-studio
https://www.iho.int/iho_pubs/standard/S-44_5E.pdf


 

 

The information contained on this sheet is subject to restrictions listed on the cover page of the document 

Version 1.04 – 16/03/20 Page 2 ETD-2017 

Unclassified 

www.iter-systems.com  

support@iter-systems.com 

2 INSTALLATION 

2.1 INSTALLING THE SOFTWARE 

Use these instructions to install PSM_Report on any computer, for reprocessing, testing or 
setting up the configuration files. 

The PSM_Report software is provided as a single zipped file, PSM_Report.zip. All the necessary 
external Java .jar library files are provided with the installation. 

Unzip this file to a suitable location, and run the software from there.  

The PSM_Report is a Java application, so the latest Java Runtime Environment (JRE) is required 
[Ref 3]. PSM_Report will run on any operating system that supports the JRE.  

 

2.2 INSTALLING ON A PSM SYSTEM 

Use these instructions to set up a PSM system on site. 

These instructions will be used whilst setting up the rest of the PSM scripts, etc.  

2.2.1 Logging In 

◼ Connect to the VPN network that has been set up for communications with the PSM 
system. 

◼ Use Remote Desktop to log in to the on-site computer. 

2.2.2 Folder Structure 

Create the following folders: 

◼ C:\CSM Cloud Data 
◼ C:\CSM Cloud Data\reports 
◼ C:\CSM Cloud Data\Scheduler 
◼ C:\CSM Cloud Data\sonar 
◼ C:\CSM Cloud Data\sonar\raw 
◼ C:\PSM_Report 
◼ C:\_Software\Sonar Software 

2.2.3 Install Bathyswath Software 

◼ Copy either bathyswath_x64.msi (for 64-bit computers) or bathyswath_x86.msi (for 
32-bit computers) to C:\_Software\Sonar Software, and double-click on it to install the 
Bathyswath software 

◼ Copy the PSM Bathyswath session file (currently this is, confusingly, called 
“altimeter.sxs”) to “C:\CSM Cloud Data\Scheduler” 

2.2.4 Configure Bathyswath Software 

◼ Double-click on the session file (e.g. “altimeter.sxs”) to run Swath Processor. 
◼ If the pan sweep starts automatically, stop it in Swath Processor using Configuration > 

Pan and Tilt > Automation > Stop. 
◼ In the Pan and Tilt dialog (Configuration > Pan and Tilt), carefully use Fixed Angle 

Control to move the head to angles either side of zero to check the view of the sonar.  
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◼ The head should have been set up so that a pan angle of zero (0) is pointing 
directly outwards (e.g. at right angles to a dam wall), and negative angles point 
to one side and positive to the other. In most configurations, the pan head is 
mounted upside-down, so that positive pan angles move the head anticlockwise 
when viewed from above (to the left) and negative angles move it clockwise (to 
the right). 

◼ Check the record physical installation of the head for the angles that the sonar 
head can safely be moved to either side of zero. If it is safe to do so, start by 
moving the head to, say -80°. 

◼ Use the Sonar control to start the sonar: click Start and select Transmit Enable. 
◼ Select Configuration > Attitude Derivation > Testing > Test Mode; this is needed 

when the pan head is not running, otherwise the software fails to show profiles 
and reports “Ping rejected without bathymetry calculation. Heading not found.”. 
Don’t forget to disable Test Mode once the sonar angles are set up. 

◼ Watch the Cross Profile display to check the sonar returns, and determine the 
useful range of angles that the pan sweep should cover.  

▪ Note: a concrete dam wall acts like a mirror to the sonar signals, so an 
image of the lake bed can still be obtained when the pan head is rotated 
so that the transducers are pointed at the wall. Some care and caution is 
needed here! 

◼ When the limits of the sweep have been found, set up the sweep in the 
Automation section of Pan and Tilt Control.  

▪ Enter the limit angles into the Start and End boxes  
▪ Enter the angle step between pings in Increment. This is usually between 

0.2 and 0.5 degrees. A small number will give better resolution around 
the sweep, but could make the sweep take too long for the telemetry 
system. 

▪ Enter the number of Pings per Step: e.g. 1 to 5.  
◼ Set up the conversion of the angle from the pan head to heading, in Pan to 

Heading 
▪ In most PSM systems, the pan head is mounted upside down, with the 

transducers hanging beneath the pan head. In that case, enable Pan to 
Heading > Change Sign. 

▪ Enter the compass direction that the transducers are pointing when the 
pan head is at zero in Pan to Heading > Corrected Heading. 

◼ For pan heads that require a homing sequence, enable Homing > Home at Start 
and Home at End. 

◼ Set up the Sonar parameters 
◼ Use the Sonar dialog to set the sonar running, and enable Test Mode (see above 

for details) 
◼ Use the Pan and Tilt controls Fixed Angle Control to rotate the head to the place 

where the longest sonar range is seen 
◼ Use the Sonar control to optimise the configuration: 

▪ Set Power to maximum 
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▪ Increase the Pulse Length until the distance seen and data quality stop 
increasing, and then reduce it slightly 

▪ Set the Ping Range slightly longer than the maximum range seen 
◼ In Attitude, set up the port and data format that match the attitude sensor fitted 
◼ In Auxiliary 1, Auxiliary 2, and Auxiliary 3, set up the ports and data formats for: 

◼ The Sound Velocity Sensor 
◼ The Pan head 
◼ The thermal array (if fitted)  

◼ Use Tools > Bathy Filters to tune the filters to give the best sonar profile at maximum 
range.  

◼ Start with the filter tab on the left and adjust each in turn to give the best results.  
◼ Take care to ensure that there are no reflections from the dam wall or water-

column noise affecting the profile close to the dam: this area is usually the most 
important for PSM applications.  

◼ It might help to disable the Binning filter until the other filters have been 
optimised.  

◼ In Configuration > Project Structure 
◼ Enable Use Project File Structure  
◼ Set Raw Data > Directory to “..\sonar\raw”. 
◼ Set Processed Data to “..\sonar\proc” 

◼ In Proc File 
◼ Enable As Raw File 
◼ In Props, set 
◼ Output file format > ASCII File (TXT) 
◼ Enable Invert sign of depths  

◼ In Configuration > Sensor Offsets, set the locations of the sonar transducer and 
attitude sensor, relative to a fixed reference point on the sonar head, which can be any 
convenient point 

◼ In Configuration > Attitude Derivation, set  
◼ Roll derivation > Attitude sensor roll 
◼ Pitch derivation > Attitude sensor pitch 
◼ Heading derivation > Pan & tilt head 
◼ Height derivation > Use fixed value 

▪ Enter the calculated altitude of the reference point   
◼ In Configuration > Position Parameters, set  

◼ Position Use > Use Fixed Value 
◼ Fixed value: enter the calculated easting-northing location of the reference 

point 
◼ The Swath Processor Windows are not essential for automated operation, but they 

are very useful for diagnostics through a remote login 
◼ Useful windows are: 

▪ Cross profile 
▪ Text (configure to see Raw Data, Attitude, and Raw Port Text) 
▪ Coverage 
▪ Amplitude 
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2.2.5 Install PSM_Report 

◼ In Windows File Explorer, navigate to “C:\PSM_Report”, 
◼ From the PSM_Report software distribution, copy PSM_Report.zip to 

“C:\PSM_Report”, and extract the files into it, so that you have 
“C:\PSM_Report\input”, “C:\PSM_Report\manual”, “C:\PSM_Report\output”, etc. 

◼ Ensure that the Java Runtime Environment (JRE) is installed on the computer. 

2.2.6 Configure PSM_Report 

◼ In “C:\PSM_Report”, double-click on “run_PSM_ReportConfig” to run the 
configuration tool: 

◼ In the Project tab: 
▪ Set Outputs folder to “C:\CSM Cloud Data\reports”. 
▪ Set File name prepend to a short form of the name of the site, e.g. “Riou”. 

This will be added to the name of all data files recorded. 
▪ Leave Show PDF file off. 
▪ In most cases, set Input data number format to “en”. This uses the English 

number format “1234.56” instead of the European one “1234,56”. If the 
system needs to read in data files in the latter format, enter “fr”.  

◼ In the Report tab: 
▪ Set Language to the one required for the reports at this installation: e.g. 

“Fr” for French or “En” for English. 
▪ Two logos can be shown at the top of each page. Put graphics files for 

these in “C:\PSM_Report\input”, and specify their names in Logo 1 and 
Logo 2, e.g. “DTG_logo.png”, 

▪ First page note specifies text that is shown at the bottom of the first page 
of the reports, 

▪ Remarks are shown at the bottom of every page of the report. 
◼ In the Positions tab: 

▪ Enter the easting, northing and height of the transducer,  
▪ Enter the full supply level, Minimum operating level and maximum water 

level of the lake, 
◼ In the Plan View tab: 

▪ Enter the names of the Geodetic system, e.g. “Lambert 93” and Height 
datum, e.g. “IGN69”. 

▪ Copy a geo-referenced image file for the background of the colour-depth 
map in the report to “C:\PSM_Report\input”. PSM_Report cannot 
currently show TIFF files, so if one of those is supplied, use an image 
processing application (e.g. Microsoft Paint) to convert it to .bmp. 

▪ Enter the name of the file into Background image file, e.g. 
“Riou_FdP1_PSM.bmp” 

▪ Enter the name of the geo-referencing file into Background image 
geo file, e.g. “Riou_FdP1_PSM.tfw” … 

▪ … or if no geo-referencing file is available, leave Background image 
geo file blank, and enter the co-ordinates of the image into 
Background origin and Background extents. 
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▪ Enable Show the background map, Show the distance scale, and Show 
the colour-depth scale. 

◼ In the Depth Colours tab: 
▪ Leave the colour settings as default unless you want a different colour 

scale. 
◼ In the Segment Plots tab: 

▪ Set the min and max values for the plots according to the range of values 
that are seen in the profile and histogram data.  

▪ You won’t know what these are until the system has run a few 
times. Then, you can inspect the 
“C:\PSM_Report\input\history*.txt” files to see what values are 
being created.  

▪ Set Histogram time scale to day, week, month or year as required. See 
4.6.7 for details of these options. 

◼ In the Height data tab: 
▪ Depth data file can be left blank except for testing, 
▪ Leave the other items as their default settings for now. 

◼ In the Segments tab: 
▪ Enter the number of segments to show in Number of segments. Then 

press the Enter key to refresh the tabs for the segments. 
▪ At first, enable Save profiles to file, but disable it after the first run. 
▪ In Profiles folder, enter “C:\PSM_Report\output”. 

◼ In the separate Segment (n) tabs: 
▪ Enable Show segment, 
▪ Enter the colour to show the segment in, using English or French, 
▪ Give the segment a title, e.g. “Segment no. 1 [A-B]”, 
▪ Enter the start and end positions of the profile. You can compute these 

using a spreadsheet compute the end points from the start point (usually 
at the transducer) and a heading and length for each profile, 

▪ Enter a Reference level (usually above the height of the profile), 
▪ Enter a Reference profile file name: see “Creating Reference Profiles” 

below, 
▪ Enter a History file name, e.g. “history1.txt” for the first profile, etc. 

2.2.7 Creating Reference Profiles 

◼ When you run PSM_Report with Save profiles to file enabled in the Segments tab, a 
profile file is stored for each profile in “C:\PSM_Report\output”. 

◼ After the first run, check the profile files that are stored: there should be one for each 
profile. If you are happy with them, copy them from “C:\PSM_Report\output” to 
“C:\PSM_Report\input”, and specify them in Reference profile file name in the 
separate Segment tabs. 

◼ Then, de-select Save profiles to file in the Segments tab. 
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2.3 TESTING THE PSM_REPORT SYSTEM 

To test a PSM_Report setup after configuring it: 

1. Run the scan by double-clicking on “C:\CSM Cloud Data\Scheduler\altimeter.sxs” (or 
whatever the default Bathyswath session file is called). This should create a .txt output 
file in “C:\CSM Cloud Data\sonar\proc”. The file name is encoded from date and time, 
in the format YYYYMMDD_HHMMSS. 

2. Right-click on “C:\PSM_Report \test_PSM_Report”, and select “edit” 
a. Enter the location and name of the .txt output file that was created above 

after the –d command, e.g.  
"..\CSM Cloud Data\sonar\proc\20161202_164946.txt" 

3. Double-click on “C:\PSM_Report \test_PSM_Report” to run it 
4. Check for errors in the Command Window that opens 
5. If PSM_Report completes without errors, a PDF report should have been created in 

“C:\CSM Cloud Data\reports”. Double-click on it to open it and check it. Even if the 
Adobe PDF reader is not installed, the file should open in a browser. 

6. After PSM_Report has been run once, you can enter correct min and max values in the 
Segment Plots tab of the configuration tool 

7. Open each of the “history*.txt” files in “C:\PSM_Report\input”. On each line, the last 
entry is the “Ref level history”, so enter a minimum and maximum that cover that 
entry with scope for movement up and down. The number before that is used for the 
“Ref profile history”, so enter a Ref profile history min and Ref profile history max 
that are suitable for that value. These values can be negative if necessary.  

8. After changing the min and max values for the histogram plots, run test_PSM_Report 
again to check that the histograms. 
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3 QUICK START 

3.1 CONFIGURE THE SYSTEM 

To set up PSM_Report, run the configuration tool, PSM_ReportConfig. This is a Java 
executable. A Windows script is provided to run it: “run_PSM_ReportConfig.cmd”: double-
click on this file to start the configuration application. 

 
 

The dialog has several different tabs, with settings for different parts of the system. 

 

PSM_ReportConfig saves the settings to a configuration file, “PSM_Report_config.txt”, and 
this file is read by the main PSM_Report application. By default, it is stored in the “input” 
folder; see 5.2.4 for using other locations and file names.  

There are two ways to set up PSM_Report on a remote computer: 

1. Log in to the remote computer using Remote Desktop, and run PSM_ReportConfig 
there, or 

2. Run PSM_ReportConfig on your own computer, and then upload the 
“PSM_Report_config.txt” file that it creates to the remote computer, for example 
using FTP. 

 

 

3.2 CREATE THE REPORT 

The PDF report is created using “PSM_Report.jar”, which is a Java executable. In Windows, a 
command script, “run_PSM_Report.cmd” is provided to run it. This uses a depth data file, 
which can be specified in the configuration tool (if it is always the same name) or passed in as 
an argument to the application.  
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When PSM_Report is run automatically at regular intervals, the name of the data file is likely 
to be different for each run. In this case, use the “run_PSM_ReportArg.cmd” command script, 
which accepts the file path of the data file as an argument, for example: 

run_PSM_ReportArg “C:\PSM\sonar\proc\ 20160509_153127.txt” 

 

The PDF report is placed in an output folder that is specified by the configuration tool, and is 
given a name including the time and date when the report was created. 

 

If further actions need to be taken after the report has been created, extra lines could be added 
to the run_PSM_Report.cmd or run_PSM_ReportArg scripts. 
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4 CONFIGURATION TOOL 

4.1 STARTING 

4.1.1 Calling with Windows Command Script 

Double-click on “run_PSM_ReportConfig.cmd” to start the configuration application. 

4.1.2 Calling with Java 

The configuration tool application is contained in a Java jar file, “PSM_ReportConfig.jar”. It can 
be run in a command window or command script using: 

java -jar PSM_ReportConfig.jar 

 

Arguments can be added to this call, to refine the function of both the Java Runtime Engine 
(JRE) and PSM_ReportConfig. See sections 4.1.3 and 4.7. 

 

In some versions of the JRE, you can double-click on PSM_ReportConfig.jar to run it in the JRE. 
However, that might not supply the correct arguments (see below), so the results might not 
be correct. 

4.1.3 Java Number Formats 

Different countries use different formats for numbers when they are saved or read as text. 
English-speaking countries use “123.45”, and French speakers use “123,45”. 
PSM_ReportConfig and PSM_Report can use either format, but it is important to be consistent: 
if the configuration file is written in one format and PSM_Report reads it in another format, 
then the numbers will be read wrongly and the results incorrect, often leading to the Java 
application terminating with an error. 

To be sure of using the right format, Java can be called with arguments that define the formats 
used, for example, to ensure use of the English format, use: 
java -Duser.language=en -Duser.country=EN -jar PSM_ReportConfig.jar 

Make sure that the Duser arguments come after “java” and before “-jar”. 

 

The arguments that are passed to PSM_ReportConfig.jar are listed in section 4.7. 

4.2 LAYOUT 

PSM_ReportConfig is a dialog-based graphical user interface (GUI). It is divided into a number 
of separate “tabs”; click on the tab at the top of the window to see the parameters in each 
section. 

 
  

tabs 
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4.3 SAVING AND QUITTING 

To save the results to the configuration file and quit, click the “OK” button at the foot of the 
dialog. To quit without saving the results, click “Cancel”. 

 
 

The version of the tool is also shown at the footer of the dialog window. 

The settings are saved in the configuration file, “PSM_Config.txt” see 6.10. 

4.4 LABELS AND TOOL TIPS 

Most of the editable parameters in the dialog have a label explaining what the parameter does. 
For more information, leave the mouse pointer over the entry for a few seconds, and a “tool 
tip” appears. 

 
 

4.5 SAVING THE SETTINGS 

Click the OK button to save the settings back to the configuration file and close the dialog. Click 
Cancel to close the dialog without saving the settings to the configuration file.  

4.6 SECTIONS 

4.6.1 Project 

The first tab defines the settings of the PSM_Report project. 

The settings are: 

◼ Template folder: defines where the “.jasper” files are stored, which are used by the 
JasperSoft application to create the report. See section 6.11. 

◼ Inputs folder: defines where input data for the report is stored. This may be over-
ridden by an argument to the PSM_Report call. This over-ride is generally necessary, 
because the configuration file, “PSM_Config.txt”, where these parameters are stored, 
is itself stored in this folder. 

◼ Outputs folder: defines where the PDF reports are stored after they are created. 
◼ File name prepend: this text is added to the front of the file name given to each of the 

PDF report files that are created. See 6.3.4. 
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◼ Show PDF file: if this option is ticked, then a PDF reader (e.g. Adobe Acrobat) is called 
with the name of the newly-created PDF file to show it on the screen at the end of 
each run. This option is generally only used to test the system, and should not be 
enabled on automated systems on remote computers, otherwise the screen on the 
remote system could be filled with instances of the PDF reader, and it might not be 
possible to move or delete the PDF files if they are open in the PDF reader.  

◼ PDF Reader: the name and location of the program that is used to display the PDF file, 
when “Show PDF file” is selected.  

◼ Input data number format: PSM_Report reads its input data (depth data and 
reference profiles) from ASCII text files. ASCII numbers are represented in different 
ways in different countries (“locales”); in the UK and USA, numbers are shown as 
“1234.56”, but in France and other European countries, they are shown as “1234,56”. 
Enter “EN” for English format, and “FR” for French (other standard locale codes may 
work, but have not been tested). This selection only for the input data files, and is 
independent of the number format selection used for the report and “PSM_Config.txt” 
configuration file. 

4.6.2 Report 

This tab defines the settings of the report PDF file. 

◼ Language: use the drop-down box to select the language to be used to create the 
report and the console messages output when PSM_Report runs. The system currently 
supports “FR” for French and “EN” for English. See 6.12. 

◼ Logo 1: the file name of the first logo file shown at the top of the report. These files 
are stored in the templates folder, which is specified in the Project tab. 

◼ Logo 2: the file name of the second logo file shown at the top of the report.  
◼ Site name: this is the site name that appears in the report 
◼ Report date: if you leave this blank, then the software puts the current date and time 

in the report. Otherwise, it puts in the date and time given here. 
◼ First page note: the text entered into this box is placed in the footer of the first page 

of the report. 
◼ Remarks: this text appears at the bottom of every page except the first. 

4.6.3 Positions 

This defines the position data that is shown in the report. 

◼ Transducer position: the location of the “wet end” of the PSM system. To be more 
exact, this is generally the centre of rotation of the pan head; the transducer rotates 
around this position. 

◼ FSL; full supply level: the highest water level of the lake for providing power 
◼ MOL; min. operating level: the lowest design water level 
◼ MWL; max. water level: the highest water level in the lake 

4.6.4 Plan View 

The parameters of the plan view that is shown in the report. The plan view shows the 
surroundings of the site and the depth data.  

◼ Geodetic system: the projection system used to create easting-northing positions 
from latitude and longitude 

◼ Height datum: the system that defines the zero-height, which all heights are measured 
relative to. Note that heights are shown as positive upwards (as opposed to the 
positive-down convention used for depths at sea). 
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◼ Background image file: the name of the image file giving a background picture of the 
site. This needs to be bitmap (.bmp) or JPEG (.jpg). PSM_Report does not currently 
support TIFF files (.tif), and so they need to be converted, using a standard image-
processing tool, for use with PSM_Report. 

◼ Background image geo file: the name of the file that contains the geographic 
coordinates of the background image. This is a standard format for geographic image 
files, typically .tfw or .jfw. Leave this blank to define the Background origin and 
Background extents yourself. 

◼ Background origin: if the Background image geo file is left blank, then this defines the 
position of the lower-left corner of the background image. Note that .tfw files define 
the upper-left corner.  

◼ Background extents: if the Background image geo file is left blank, then this defines 
the width and height of the background image in metres on the ground. 

◼ Show the background map: select to show the background map (otherwise the colour-
depth map of the depths is shown without the background map) 

◼ Show the distance scale: select to add a distance scale bar to the map 
◼ Show the colour-depth scale: select to add a colour-depth key to the map  

4.6.5 Depth Colours 

This tab allows the user to select the colours that are used to create the depth map in the 
report. 

◼ Number of colours: defines the number of colours that are used. This must be in the 
range 1 to 10. After entering a new number, press the Enter key to refresh the dialog 
with the new range of colours. 

◼ Colour band width: defines the range of heights that have the same colour.  
The default setting is to use 10 colours, each with a width of 1 metre. This means that 
the full range of colours covers 10 metres, before re-starting. So, heights between 0.0 
and 0.99 metres are shown in the first colour, heights between 1.0 and 1.99 m are 
shown in the second colour, etc. At 10.0m, the colours start again, so that 10.0 to 10.99 
is shown in the first colour, 11.0 to 11.99 in the second, and so on. 

◼ Setting the colours: 
◼ Ten colour bands are provided; the number used is defined in the “Number of 

colours” field 
◼ The colour is shown as: 

▪ A number, representing red, green, and blue components, each as a 
number from 0 to 255, in the format: [red + green * 256 + blue * 256 * 
256]. 

▪ A coloured box 
◼ To change the colour: 

▪ Click on the coloured box in the “Set” column, then select a new colour 
using the colour-chooser tool on the right, or  

▪ Enter a new colour number in the “Number” box 
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4.6.6 Height Data 

This defines the input data XYZ file and the way that it is processed. The format of these files 
is described in section 6.5. The PSM_Report software stores the height data in a digital terrain 
model (DTM); see section 6.6. 

◼ Depth data file: this gives the full path name of the data file (directory and file name). 
The name of this file can also be passed in as an argument to the PSM_Report 
executable, in which case this entry is ignored. 

◼ Grid bin size: the DTM contains a rectangular array of square “bins”. Height data points 
from the input depth data file are averaged into a grid bin, according to their position. 
The grid bin size defines the length of the sides of each square. If this is too small, then 
there will be many bins without data in them, and if it is too large, then fine details of 
the lake bottom will not be resolved. The default is 1 metre.  

◼ Do spike filter: select this to run a “spike filter” over the grid. This filter removes entries 
in the DTM that are significantly different from their neighbours. (Such entries appear 
as “spikes” if viewed in 3D). It does this by looking at square “windows” of data in the 
DTM and removes any values that are more than a certain height away from the 
median height in the window. The value is also removed if the window has too few 
entries in it. 

◼ Spike filter window size: the size of the moving-window used, in grid bins. E.g. 
a value of 5 defines a window of 5x5 bins. 

◼ Spike filter min. occupancy: if the number of bins in the window is less than this 
fraction, then the central value is removed. The value entered must be between 
0 and 1. For example, if the window size is 5 and the occupancy is 0.3, then there 
must be at least [5x5*0.3 = ] 7 bins filled out of the possible 25. 0.3 is the same 
as 30%. 

◼ Spike filter max. height diff.: the maximum allowable difference in height 
between the centre bin and the median of the bins in the window 

◼ Do smoothing filter: select this to run a smoothing filter over the grid 
◼ This smooths out small-scale variations in the grid, making the trend easier to 

see. It also fills in gaps in the grid. It runs a square window over the grid, and 
replaces the centre value with the mean of values in the window. 

◼ Smoothing filter window size: the size of the window used, in bins 
◼ Smoothing filter min. occupancy:, just as for the Spike filter min. occupancy, 

smoothing is not done if there are not enough values in the window. 

4.6.7 Segment Plots 

The report shows information for a number of line segments in the area scanned by the sonar, 
as line profile plots and histograms. This section defines the parameters of those plots. 

Three plots are shown: 

◼ Line profile plots, with height and linear distance scales, and showing: 
◼ The latest height profile in that segment, 
◼ The height profile of a reference profile, recorded at some previous time, 
◼ A reference level, 
◼ The standard deviation of the heights in the DTM. 

◼ History of the mean height difference between the reference profile and the current 
profile, shown as a histogram of measurements, with the most recent on the right. 
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◼ History of the mean height difference between the reference level and the current 
profile, shown as a histogram of measurements, with the most recent on the right. 

The settings are: 

◼ Profile min height: the lowest height shown in the profile plots. 
◼ Profile max height: the highest height shown in the profile plots. 
◼ Quality plot range: the quality data is shown as a standard deviation, and plotted into 

the height window with zero at the bottom of the plot, and the quality plot range at 
the top of the plot. The default is 1.0, so a standard deviation of 1 is shown at the top 
of the plot, and a standard deviation of 0.5 is shown in the middle of the plot. 

◼ Ref. profile history min: the minimum difference shown in the reference profile 
histogram, shown as metres (m). 

◼ Ref. profile history max: the maximum difference shown in the reference profile 
histogram (m). 

◼ Ref. level history min: the minimum difference shown in the reference level histogram 
(m). 

◼ Ref. level history max: the maximum difference shown in the reference level 
histogram (m). 

◼ Histogram time scale: use the drop-down box to enter “day”, “week”, “month”, or 
“year”: 

◼ Year: the current day, plus a value on the same day of the week as the current 
scan, since records started. 

◼ Month: the current day, plus a value for each of the previous three weeks, on 
the same day of the week as the current scan. 

◼ Week: the current scan and the previous 6 days, at the same time as the current 
scan. 

◼ Day: all the scans taken in the previous 24 hours are shown. 

4.6.8 Segments 

This tab controls the line segments that are used to analyse the history of change in the survey 
area.  

◼ Number of segments: this defines the number of line segments that are used in the 
analysis and shown in the report. Enter the number of segments, and then press the 
Enter key; this causes the dialog to show the appropriate number of tabs, one for each 
segment. 

◼ Save profiles to file: select this to save a text file for each segment that gives the lake 
bottom height and distance along the segment line. The name of each file is derived 
from the time, date, and segment name, for example “20160707_145859_Segment 
no. 1 [A-B].txt”. These files can be copied to the “input” directory, and used as 
reference profiles.  

◼ Profiles folder: if Save profiles to file is selected, then the files are stored to the folder 
defined here.  

 

Caution: the system stores a history of depth differences for each segment, which is shown in 
the histograms in the report. Removing a segment may also remove its history data. That 
history data may be difficult to restore once it is lost. 
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4.6.9 Segment 1, etc. 

The information for each segment is shown in a separate tab. The number of Segment tabs 
shown is defined by Number of segments in the Segments tab. 

◼ Show segment: select to show the information for this segment in the report. 
◼ Colour: the colour that the segment is shown in the plan view. Enter a colour name in 

English or French, e.g. “red” or “rouge”.  
◼ Start: easting-northing position of the start of the segment. 
◼ Ref: text shown at the start of the segment in the plan view (usually a single letter). 
◼ End: easting-northing position of the end of the segment. 
◼ Ref: text shown at the end of the segment in the plan view (usually a single letter). 
◼ Reference level: a reference level is shown in the profile line plot, and a history of the 

mean difference between this level and the current profile is computed and plotted in 
a histogram. 

◼ Reference profile file name: an XZ file is provided to define a reference profile for this 
segment, recorded at some point in the past, for comparison. This file must be in the 
“inputs” folder, defined in the Project tab. 

◼ Reference profile date and time: the date and time that the reference profile was 
recorded.  

◼ Delete segment button: use this to delete the defined segment. An “are you sure” 
dialog appears: click “yes” to confirm that you wish to delete this segment. See the 
caution above about deleting segments and thereby losing their history information. 

4.7 PSM_REPORTCONFIG ARGUMENTS 

PSM_ReportConfig.jar accepts arguments when it is called, as follows: 

Argument Function Action if absent 

-i <input folder name> Defines the path of the folder that 
contains the configuration file 

If empty, uses default 
"input" 

-p <parameter file name> Defines the name of the 
configuration parameters file 

If empty, uses default 
"PSM_Report_config.txt" 

-? prints the usage message  
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5 REPORT FUNCTION 

5.1 INTRODUCTION 

The PDF report is created by “PSM_Report”.  

5.2 CALLING PSM_REPORT 

The application is contained in “PSM_Report.jar”, which is a Java executable.  

5.2.1 Calling with Command Scripts 

Two command scripts are provided to run PSM_Report: 

◼ run_PSM_Report.cmd: this runs PSM_Report with the default settings, including 
reading from the configuration file in the default location, and then uses the name of 
the data file defined in the configuration file.  

◼ run_PSM_ReportArg.cmd: this runs PSM_Report with the name of the data file passed 
in to the command file as an argument. This can be used when the name of the data 
file changes with each run of the system. 
For example: 
run_PSM_ReportArg “C:\PSM\sonar\proc\20160509_153127.txt” 

 

The PDF report is placed in an output folder that is specified by the configuration tool, and is 
given a name including the time and date when the report was created. 

 

If further actions need to be taken after the report has been created, extra lines could be added 
to the run_PSM_Report.cmd or run_PSM_ReportArg scripts. 

 

5.2.2 Calling with Java 

The configuration tool application is contained in a Java jar file, “PSM_ReportConfig.jar”. It can 
be run in a command window or command script using: 

java -jar PSM_Report.jar 

 

Arguments can be added to this call, to refine the function of both the Java Runtime Engine 
(JRE) and PSM_ReportConfig. See sections 4.1.3 and 6.10. 

In some versions of the JRE, you can double-click on PSM_Report.jar to run it in the JRE. 
However, that might not supply the correct arguments (see 6.2), so the results might not be 
correct. 

5.2.3 Java Number Formats 

See section 4.1.3 for a note on the importance of using a consistent number format. 

5.2.4 Inputs 

To create the report, PSM_Report needs a number of inputs: 

◼ A settings file, “PSM_Report_config.txt” 
◼ An XYZ height file (see section 6.5.1) 
◼ Reference profile height files (see section 6.5.2) 
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5.3 PSM_REPORT ARGUMENTS 

PSM_Report.jar accepts arguments when it is called, as follows: 

Argument Function Action if absent 

-i <input folder name> Defines the path of the folder that 
contains the input data files 

Uses default "input" 

-p <parameter file name> Defines the name of the 
configuration parameters file 

Uses default 
"PSM_Report_config.txt" 

-d <height data file> Defines the full path of the height 
data file 

Uses the 
inputDepthDataFile 
parameter in the user 
inputs 

-? prints the usage message  

 

It is necessary to specify the name of the input folder as an argument, because the 
configuration file, PSM_Report_config.txt, is itself placed in that input folder. 
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6 SPECIFICATION 

6.1 OVERVIEW 

PSM_Report performs the following functions: 

◼ Run on the same computer that runs the software that controls the Bathyswath-2 PSM 
hardware and processes its data.  

◼ Produce reports in PDF format, containing the following sections. See 6.3.3 for details. 
◼ Title and header text, 
◼ Colour-depth map of the scanned area, 
◼ One or more depth profile plots for selected lines across the scanned area,  
◼ Analysis of the area in the cross-profile under the selected depth, showing 

changes in siltation. 
◼ Save reports with file names showing date and time of the scan that they report, 

formatted so that they appear in time order in tools such as Windows Explorer. 
◼ Run on Windows, versions XP and later. 
◼ Provide reports in French or English language (other languages can easily be added). 
◼ Provide a configuration tool, allowing the client’s engineering team to modify the 

operation of PSM_Report. 

 

PSM_Report can work with systems other than Bathyswath-PSM, and to support this: 

◼ The software reads in ASCII XYZ files, which most sonar systems can supply, 
◼ The software is stand-alone and separate from the Bathyswath software. 

6.2 OPERATING SYSTEMS 

PSM_Report is written in Java, so it runs on any operating system that support the Java 
Runtime Environment (JRE), which is almost all operating systems. The Bathyswath software 
runs only on Windows, and Windows command files are provided to help running 
PSM_Report. 

6.3 REPORTS 

6.3.1 Format 

The Reports are provided in PDF format [Ref 2]. This was developed by Adobe, but is now an 
open standard, specified by ISO 32000-1:2008. PDF documents can be read using free 
applications, which are available for all commonly-used operating systems. 

6.3.2 Language 

The Reports are supplied in French and/or English language. The system supervisor can specify, 
using the Configuration tool, that the Application produces reports in French, in English, or 
both. Other languages may be added in later versions of the system.  

6.3.3 Contents 

An example of the reports provided by PSM_Report is shown in the appendix at the end of this 
document. The system supervisor can modify the Report formats using the Template Editor 
tool.  

The document sections are: 

◼ Title and header text, including: 
◼ Location of the PSM system (name of dam, power station, etc.) 
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◼ Security classification (access to the reports will be limited to certain personnel 
only; this will vary between PSM sites) 

◼ Date and Time of the data that the report was prepared from 
◼ Date of preparation of the report 
◼ Status: any system error states, any warnings of change of sediment volumes 

exceeding user-set limits 
◼ Colour-depth map of the scanned area, including: 

◼ Colour-coded depths 
◼ Depth-colour key 
◼ Position grid, easting-northing projection 
◼ Location of the head 
◼ Location of one or more selected cross-profiles, shown as lines on the map 
◼ Addition of background vector or raster map data, if available 

◼ One or more Cross-profile plots, for each selected cross-profile, showing: 
◼ 2D (depth and horizontal distance) plot of depths in the selected cross-profile 
◼ A horizontal line at a selected fixed depth 
◼ Numbered axes, showing depth and distance along the cross-profile 

◼ Analysis of the area in the cross-profile under the selected depth, for each selected 
cross-profile: 

◼ The cross-profile area for the current scan 
◼ A graph showing  

▪ the history of areas for the same cross-profile from the current and 
previous scans 

▪ axes showing area and date-time 
◼ Available profiles map 

◼ The profiles for which data is shown in the plots and analysis graphs are shown 
as lines in the depth colour-map 

◼ This map shows all the available profiles, shown in plan-view, with an 
identification number.  

6.3.4 File Names 

Report files are named using the following format: 

<YYYYMMDD>_<HHMMSS>_< filename base >_<LL>.pdf 

Where: 

◼ YYYYMMDD is year, month, day, 
◼ HHMMSS is hour, minutes, seconds of the time of the scan, 
◼ filename base is defined in the configuration tool, 
◼ LL is the language code, “fr” for French and “en” for English.  

 

For example:  

20150723_192247_StEgreve_fr.pdf 
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6.4 CONFIGURATION TOOL 

6.4.1 Function 

A Configuration Tool is provided, supporting: 

◼ Selection of the parameters of the Report, including: 
◼ Report filename base (date and time text are added to this to complete the 

filenames), 
◼ The name of the location of the PSM system, 
◼ Any remarks text for the report header, 
◼ The range of depths shown by the depth-difference-history graph, 
◼ Selection of logo to add at top of report pages, 
◼ The language(s) of the Report; more than one language can be selected, in which 

case one report file is provided for each language, with the language given as an 
extension to the file name (“_fr”, “_en”, etc.). 

◼ Settings of the colour-map:  
◼ Depth colour scale definition,  
◼ Source of background vector or raster map, 
◼ Geographic parameters of the background map: this can be specified using an 

associated “geo” file (e.g. .tfw), or specified as origin and extents. 
◼ Definition of the location of the transducer head. 
◼ Warning and error message controls: 

◼ Warnings given if: 
▪ Depth difference in one or more profiles falls below a user-set limit, 
▪ Negative rate of change of depth difference exceeds a user-set limit, 
▪ Non-fatal system function issues are detected. 

◼ Errors are given if: 
▪ Serious system function issues are detected. 

◼ Definition of a set of selected cross-profiles, each including: 
◼ The start point, 
◼ The end point, 
◼ The reference depth, 
◼ The date for comparison to compute percentage changes, 
◼ Depth difference limit for user warnings, 
◼ Rate of change limit for user warnings, 
◼ Whether to show this profile in the Report or not. 

6.5 INPUT DATA 

6.5.1 Height Data Files 

The PSM tool inputs the height data as ASCII XYZ files, with each height sample represented in 
a separate line of the file, space-separated, in the order easting, northing, 
height,amplitude,uncertainty; e.g. 

1234.45 2345.67 345.67 23876 1.23 

The input data is read into the DTM grid for filtering before the output profiles are extracted 
for display. The input data may come from: 

◼ XYZ data from separate pings, in time order of collection. 
◼ XYZ data from an externally-prepared DTM. XYZ data from one or more fixed profiles. 

The first option is the main one that is used with Bathyswath-2 PSM. In the third case, the input 
profile location must be the same as that of the output profile.  
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Amplitude is not currently used in the outputs, and so is not essential. 

Uncertainty is defined as described in Ref 6, and may be obtained from the standard deviation 
of the height data, together with information about the quality of measurement of angles, 
offsets, etc. used in height computation. Alternatively, uncertainty can be computed by the 
PSM_Report software. The outputs do not yet use this uncertainty data, so it is not yet 
essential to the working of the application.  

6.5.2 Reference Profile Files 

The reference profiles define heights along the segment lines at a fixed point in time, and are 
used for comparison to see how the surface is changing with time. 

The files are formatted as <distance along the line from start> <height>, as ASCII text, and and 
are space-separated. One height entry is on each line. For example: 

0 945.00 

2.00 945.04 

4.00 945.16 

6.00 945.35 

8.00 945.62 

6.5.3 Data Number Formats 

ASCII numbers are represented in different ways in different countries (“locales”); in the UK 
and USA, numbers are shown as “1234.56”, but in France and other European countries, they 
are shown as “1234,56”. PSM_Report can be configured to use either format, using the 
configuration tool; see section 4.6.1. 

6.6 DTM SURFACE MODEL 

The application includes a surface model, as a height grid. The colour map and profile data are 
extracted from this model. 

Data is input to the model as ASCII files, either as separate profiles or as a regular grid of 
depths. Each height point in the input data is added to the height model. After input, a “spike” 
filter removes depths that are significantly different from surrounding depths, and then an 
interpolation filter is used to fill in small gaps in the model. 

6.6.1 Parameters of the Surface Model 

The extent of the model is defined as: 

◼ Easting-northing position of the lower-left corner, 
◼ Extent of the model in easting and northing, 
◼ Size of the grid bins in metres. 

6.6.2 Colour Map 

A colour map of depths is created from the surface model. This map is inserted into the report. 
The colour map includes: 

◼ Coloured pixels, placed in XY according to the easting-northing position of each grid 
bin. Each pixel contains the depths from one or more grid bins. In most cases, there 
will be more than one bin for each pixel, so there will not be gaps between pixels. 

◼ A colour-height scale, showing the colour for each height. 
◼ A horizontal scale bar. 
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6.6.3 Colour Coding 

The colour map shows the grid as a set of pixels, with each pixel showing the height of each 
pixel as a colour.  

The user specifies: 

◼ A set of N colours, 
◼ The width W of the height bands for each colour, in metres. 

The colour usage “wraps around” after a height interval of N*W metres. 

6.7 SOURCE OF DATA 

Normally, the data is provided by the Bathyswath software; however the PSM_Report 
application is designed so that the data products can come from any data source. 

6.8 DATA ANALYSIS FUNCTION 

Sedimentation change is assessed by looking at the difference between a defined height level 
and a profile of depths on a set of lines defined in 2D plan view. Each time that PSM_Report 
runs, it: 

◼ Imports profile data from one or more data files (see above), 
◼ Computes the area between the profiles and their reference height levels, then divides 

by the length of the profile to get a mean height difference, 
◼ Stores the mean depth difference for each profile in a table, against the date and time 

of the scan, 
◼ Determines whether the volume in a profile has fallen below a user-set limit, and 

issues warnings in the header of the report, 
◼ Plots selected data for selected profiles in the Report, 
◼ Deletes any intermediate files, but retains the data tables for the profile volumes. This 

is necessary to prevent the computer’s disk from filling up. However, these files will be 
uploaded to the secure database maintained by Evolutis. Therefore, such file clean-up 
will be delayed until the upload has been done, or perhaps be handled by the upload 
application. 

 

6.8.1 Adding New Analysis Profiles 

Because the intermediate files are deleted each time the process runs, it is not possible to add 
new analysis profiles and compute their height changes from dates before the new profiles 
are added. To analyse data from profiles that are added at a later date, it will be necessary to 
re-compute using the historical data that is uploaded to the data server.  

 

6.9 MODES OF OPERATION 

PSM_Report supports two modes of operation: 

◼ Automatic: 
◼ The system starts automatically after each data acquisition cycle of the PSM 

system. 
◼ Manual 

◼ The system is run manually by an operator, using data that the operator 
specifies 
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6.10 CONFIGURATION FILE 

A configuration file is located in the same directory as the PSM_Report application, and is read 
by the application each time it runs to set the user-configurable options. 

This file is a simple ASCII text file, “PSM_Config.txt”, which may be edited using any simple text 
editor, including Windows Notepad. However, it is easier to use the configuration tool to set 
the parameters in this file. 

 

The Configuration File defines the following parameters: 

◼ Selection of the parameters of the Report, including: 
◼ Site name (the name of the location of the PSM system) 
◼ Any remarks text for the report header 
◼ The range of depths shown by the depth-difference-history graph 
◼ Selection of logo to add at top of report pages 
◼ The language(s) of the Report; more than one language can be selected, in which 

case one report file is provided for each language, with the language given as an 
extension to the file name (“_fr”, “_en”, etc.) 

◼ Settings of the plan view:  
◼ Geodetic system used to create easting-northing positions 
◼ Easting and northing of origin 
◼ Easting and northing extents 
◼ Height colour scale definition  
◼ File name and format of background vector or raster map 

◼ Settings of the height profiles: 
◼ Positions of each end of the profiles 
◼ Reference height 
◼ Name of the file providing the reference profile (this has the same format as the 

new height profiles from PSM) 
◼ The date of the reference profile 
◼ Colour used to show the profile in the plan view 
◼ Whether to show this profile in the Report or not 

◼ Parameters of the surface model: 
◼ Easting-northing position of the lower-left corner 
◼ Extent of the model in easting and northing 
◼ Size of the grid bins in metres 

◼ Colours used to show colour-coded depths 
◼ Definition of the location of the transducer head 
◼ Parameters of the time-series histograms: 

◼ Time scale: 
▪ Year: each bar of the histogram shows the data for the current day, plus 

a value on the same day of the week as the current scan, since records 
started  

▪ Month: the current day, plus a value for each of the previous three weeks, 
on the same day of the week as the current scan 

▪ Week: the current scan and the previous 6 days, at the same time as the 
current scan 

▪ Day: all the scans taken in the previous 24 hours are shown 
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◼ Data quality level: the uncertainty level above which data is considered to be 
unreliable 

◼ Warning and error message controls 
◼ Warnings given if: 

▪ Mean depth difference in one or more profiles falls below a user-set limit 
▪ Negative rate of change of depth difference exceeds a user-set limit 
▪ Non-fatal system function issues are detected 

◼ Errors are given if: 
▪ Serious system function issues are detected 

6.11 TEMPLATE EDITOR 

The template files are generated and maintained using Jaspersoft Studio [Ref 5]. This is a free 
download. Some caution is needed, as the details of the report generation are rather 
complicated, and report generation could be broken with the wrong changes. However, simple 
layout adjustments are possible with minimal risk. 

6.12 LANGUAGE FILES 

PSM_Report works with various languages. Currently, English and French are supported, but 
other languages can easily be added, using new language files. 

The text that is shown in the PDF report, and in some of the user feedback, is stored in text 
files, in the input directory of the system. PSM_Report_text_EN.txt stores English text, and 
PSM_Report_text_FR.txt stores French text. 

Entries are defined in the files as <label> = <text>; for example: 

text_day   = Jour 

text_week   = Semaine 

text_month   = Mois 

 

White space (spaces and tabs) after the = sign and at the end of the entry is ignored.  

These files can (and should) be edited by the user to correct the text that is shown in the 
report. 
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7 TROUBLESHOOTING 

7.1 CONSOLE MESSAGES 

The PSM_Report and PSM_ReportConfig applications print out status and error messages to 
the “console” as they run. When these functions are run using the .cmd Windows command 
scripts provided, a Windows Command Window opens, and these messages can be seen in 
that command window.  

However, when the function completes, successfully or not, then the Command Window 
closes. To keep the Command Window open, edit the .cmd script (right-click on it and choose 
“Edit”, and enter a new line at the end of the script, with the command: 

PAUSE. This causes the script to halt with the message “hit any key to continue”. 

 

The command scripts provided finish with the following line: 

REM PAUSE 

The REM keyword causes the rest of the line to be ignored, so delete “REM” to enable the 
pause function. 
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